Geocoding tutorial
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This tutorial introduces you to geocoding with ESRI® ArcGIS™ 8. 1. It will
show you the basic techniques for creating geocoding services and
performing address geocoding with ArcGIS. Complete exercises 2 and 3 to
learn about some advanced features—using alternate names and place
name aliases and creating a dynamic feature class that is related to the
address table.

This tutorial assumes that you are already familiar with using ArcCatalog™
and ArcMap™. You should know how to copy data to a new location and
add data to a map. You should also have a basic understanding about what
a geodatabase is and the objects they can contain. If you’re new to GIS or
feel you need to refresh your knowledge, please take some time to read
Getting Started with ArcGIS. You might also work though the quick-start
tutorials in Using ArcCatalog and Using ArcMap.



Exercise 1: Locating and rematching addresses

In the first part of this tutorial you’ll learn how to create a
new geocoding service, how to locate an address on a map,
and how to create a set of point features representing street
addresses stored in a table such as customer locations.

Before you begin, you must make a copy of the data used
in this tutorial so the original tutorial data will remain
unmodified. Copy the Atlanta folder to a new location on
your computer such as the C:\ disk; you’ll find it in the
ArcTutor\Geocoding folder on the local disk where the
tutorial data was installed—for example, at C:\ArcGIS.
You’'ll need 5 MB of free disk space to store the Atlanta
folder.
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The Atlanta folder contains a personal geodatabase named
Atlanta.

Creating a new geocoding service

A geocoding service lets you convert textual descriptions
of locations into geographic features. The Geocoding
Services folder at the top level of the Catalog tree lets you
manage existing and create new geocoding services on

your computer. The first thing you’ll do is create a
geocoding service based on your copy of the Atlanta
personal geodatabase.

1. Start ArcCatalog.

2. Inthe Geocoding Services folder at the top level in the
Catalog tree, double-click Create New Geocoding
Service.
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The Create New Geocoding Service dialog box appears.

Click the geocoding style US Streets with Zone (GDB),
then click OK.
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The New US Streets with Zone (GDB) Geocoding
Service dialog box appears.

In the Name text box, replace the default name “New
Geocoding Service” with the name “Atlanta”.

In the Primary table tab, click the Browse button next to
the Reference data text box.

Mew U5 Streets with Zone [GDB] Geocoding Service

R ame: I.t’-‘n.tlanta

Description: IUS Streetz with Zone [Geodatabase)

Frimary table |

Reference data:

| =

In the Choose Reference Data dialog box, navigate to
the folder containing your copy of the Atlanta personal
geodatabase. Double-click the personal geodatabase,
click the streets feature class, then click Add.

Choosze Reference Data__

Loak in: Ia Atlanta.mdb

Mame: Islreets Add

Show of type: IPelsonaI Giendatabase feature clasees j Cancel
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7. Click OK in the New US Streets with Zone (GDB)

Geocoding Service dialog box. The new geocoding
service appears in the Geocoding Services folder.
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You’ll notice that the name of the geocoding service is
prefaced by your login name. If your login name is
“ssmith”, the geocoding service would appear in the
Catalog as “ssmith.Atlanta”. New geocoding services
are private; other users who log in to the same computer
won’t have access to your geocoding services.

When the new geocoding service is created, a
geocoding index is built for the streets feature class
within the Atlanta geodatabase. The index is stored in a
new table named GC_SZS1 in the Atlanta geodatabase.
With this index, the street features can be quickly
matched to the addresses you want to geocode.

You can modify a geocoding service’s properties after it
has been created.

Right-click the yourLogin. Atlanta geocoding service and
click Properties. The Geocoding Service Properties
dialog box appears.

On the right under Matching Options, you can see that
the default Minimum candidate score is 10. Change this
value to 30.
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10. Click OK.

Your changes are saved in the geocoding service. Now you
can use this geocoding service to find out where addresses
are located on a map.

Finding an address interactively

You can use geocoding services to locate addresses while

your are working in ArcMap.

1. Start ArcMap and click OK to create a new, empty
map.

2. Add the streets feature class in the Atlanta geodatabase
to the map.

Click the Find button on the Tools toolbar.
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In the Find dialog box, click the Addresses tab.

Before you can locate an address on your map, you
must identify the geocoding service you want to use.

Click the Browse button to choose a geocoding service.
Navigate to the Geocoding Services folder, click the
yourLogin.Atlanta geocoding service, and click Add.

Type “150 Linden Ave NE” in the Street or Intersection
text box. Type “30308” in the Zone text box.

i Find
Features I Route Locations  Addiesses |
Choose a geocoding service: Stop |
I yourLogin.Atlanta j
New Search
Street or Intersection: |1 50 Linden &ve ME j ﬂl
Zone: [3030g =l
Options... Show Standardization | ™ Show all candidates C | |
ancel
Click Find.

One candidate address appears in the list at the bottom
of the Find dialog box.

Right-click the candidate and click Add as Graphic(s) to
Map.

Right-click a row to show context menu.

Score | Side | LeftFrom | LeftTo | RightFrom | RightTo | Frelir | FreT upe | Sheeth|.
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A graphic point representing the address’s location
appears on the map.
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9. Check Show all candidates in the Find dialog box and
click Find again.

This time you’ll see several candidates in the list. All
candidates whose score is above the minimum candidate
score as defined in the geocoding service will appear in
the list. When Show all candidates is not checked, only
candidates whose score is above the minimum match
score will be listed. For this geocoding service the
minimum candidate score is 30 and the minimum match
score is 60.

10. Click the Close button in the upper right corner of the
Find dialog box.

The list of candidates is generated by breaking the address
into its individual components, then comparing each
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component to the reference data. The score indicates how
closely each candidate feature in the reference data
matches the address that you are geocoding. A score will
be lower if the street number doesn’t fall within the address
range for the candidate or if the street name is misspelled,
for example.

Geocoding addresses in a table

If you have a table that contains address information, you
can geocode all of its addresses at once. This can show you
where your customers are located.

1. Open a new map document in ArcMap. Don’t save the
map you created in the previous task.

2. Add the streets feature class and the customers table
from the Atlanta geodatabase to your map.

Click the Tools menu, point to Geocoding, then click
Geocode Addresses. Or right-click the customers table
in the Source tab of the map’s table of contents and
click Geocode Addresses.

4. Click Add.

In the Add Geocoding Service dialog box, navigate to
the Geocoding Services folder, click the
yourLogin. Atlanta geocoding service, then click Add.

(O8]

6. Click yourLogin.Atlanta in the Choose a geocoding
service to use dialog box, then click OK.



i Choose a geocoding service to use._.
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7. Inthe Geocode Addresses: yourLogin.Atlanta dialog

box, click the Browse button to define the Output
shapefile or feature class.

In the Saving Data dialog box, navigate to the Atlanta
personal geodatabase, then double-click the personal
geodatabase. Click the Save as type dropdown arrow,
then click Personal Geodatabase feature classes. In the
Name text box, type “atlanta_results™. Click Save.

Saving Data
Look in: IS Atlanta.mdb j 1>:,| alﬁl @(l &

streets
MName: Iatlanta_resulti
Save as lype: IPersUnaI Geodatabase feature classes j Cancel |

A new point feature class named atlanta_results will be
created in the Atlanta geodatabase. The point features
generated by the geocoding process will be saved in that
feature class.
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—bddress [nput Fields
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Output shapefile or feature class:
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9. Click OK to start geocoding.

When the geocoding process is finished, the Review/
Rematch Addresses dialog box appears. It shows the
statistics of the addresses that were matched or not
matched. You’ll rematch the unmatched addresses later
in the tutorial.
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10. Click Done.
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A Geocoding Result layer is added to the map. It shows the
points that were added to the atlanta_results feature class.

You can geocode a table of addresses in ArcCatalog as
well as ArcMap. To do so, you would right-click the
customers table in the Atlanta geodatabase and click
Geocode Addresses. In the Select Geocoding Service dialog
box, you would click yourLogin.Atlanta and click OK.

Then, you would follow steps 8 through 10 in the task above
to match the addresses. When you geocode a table of
addresses in ArcCatalog, the resulting feature class will not
be added to ArcMap automatically.

Rematch addresses

1. InArcMap, click the Geocoding Result: atlanta_results
layer in the table of contents.
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2. Click the Tools menu, point to Geocoding, point to
Review/Rematch Addresses, then click Geocoding
Result: atlanta_results. Or right-click the Geocoding
Result: atlanta_results layer, point to Data, then click
Review/Rematch Addresses.

(O8]

The message “This operation requires that you be
editing this workspace. Would you like to start editing?”
appears. Click Yes.

The Review/Rematch Addresses dialog box appears.
4. In the Rematch Criteria, click Addresses with
candidates tied.

Review/Rematch Addresses

[7]x]

— Statistics
tatched with goore 30 - 100 B0 [100%)
tatched with goore <300 0 [0%)
Unmatched: 0 [0%]

tatched with candidates tied: 1 [2%)
Unmatched with candidates ied: 0 [0%]

— Rematch Criteria

 Unmatched addresses
 Addiesses with score < IEU
* Addreszes with candidates tied

Al addresses
[ it this query JI

Geocoding Optiohs. .. |

| tatch Interactively I tatch dutomatically Done

5. Click Match Interactively.



The Interactive Review dialog box appears. The
address records that you have chosen to rematch are
listed at the top of the dialog box. In this exercise there
is one record in the feature class that has candidates
that are tied for the highest match score. The tied
candidates are listed at the bottom of the dialog box.
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Arrange the ArcMap window and the Interactive
Review dialog box so you can see the map. The location
of the selected candidate is highlighted on the map.

Click the second candidate in the candidate list. The
location of the highlighted candidate changes on the
map.

In the bottom right-hand corner of the Interactive
Review dialog box, click Match. The selected address in
the list at the top of the dialog box is now associated
with the second candidate in the list at the bottom.

9.

Click Close.

10. Click Done in the Review/Rematch Addresses dialog

1L

box.

As with geocoding, you can also rematch addresses
with ArcCatalog. To do so, refresh the contents of the
Atlanta geodatabase if you don’t see the atlanta_results
feature class listed in the Contents tab. Right-click the
atlanta results feature class, then click
Review/Rematch Addresses. Follow steps 4 through 8
above to rematch the addresses. When you rematch
addresses with ArcCatalog, the locations of the
candidates will not appear on a map.

On the Editor toolbar, click the Editor menu and click
Stop Editing. Click Yes to save your changes.
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Exercise 2: Using alternate names and place name aliases

A geocoding service has the option to use alternate names
and place name aliases. Place name aliases let you
associate names of well-known places with street
addresses—for example, the names of museums, hospitals,
or landmarks. When geocoding an address, the place name
alias table 1s consulted first. If found, the street address
from the place name alias table is geocoded instead.
Similarly, alternate names can be defined for features in the
reference data. When geocoding an address, the alternate
street name table is also searched to find potential
candidates.

Creating a geocoding service that uses alternate
names and place name aliases

In this task you’ll create a new geocoding service that uses
alternate names and place name aliases, then use that
service in ArcMap to find addresses.

1. InArcCatalog, click the Geocoding Services folder at
the top level in the Catalog tree, then double-click
Create New Geocoding Service.

2. Click the geocoding style US Streets with AltName
(GDB), then click OK.
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Create New Geocoding Service

Select the geocoding style to be provided by thiz service:

1J5 One Fange [File) =]
LS One Range [GOE)

US One Range with Alth ame [GDE)

LIS One Range with Zone [File]

US One Range with Zone [GDE]

LS One Range with Zone and AltMame [G0E]
LS Streets [Filg]
LS Streets [GDE]
(LIS Shreets with Al ame
LIS Streets with Zone [Filg]

LS Streets with Zone [GDE)

LIS Streets with Zone and AlkH ame [GDE] ;I

— Dezcription
LIS Streets with Alkermate Mames (Geodatabase]

The New US Streets with AltName (GDB) Geocoding
Service dialog box appears.

In the Name text box, replace the default name “New
Geocoding Service” with the name “Atlanta AltName”.

In the Primary table tab, click the Browse button next to
the Reference data text box.

New U5 Streets with AltName [GDB] Geocoding Service

Mame;

IAtIanta_.-’-‘«ItN ame

Descriptian: IUS Streetz with Alkermate Names [Geodatabasze]

Primary table | &lternate Mame table I

Reference data:

In the Choose Reference Data dialog box, navigate to
the Atlanta personal geodatabase. Double-click the
personal geodatabase, click the streets feature class,
then click Add.



6. In the New US Streets with AltName (GDB)

Geocoding Service dialog box, click the Alternate Name e Adiess ek
table tab. The field containing: iz recognized if it iz named:

7. Click the Browse button next to the Reference data text v add |
box. Stieet
) ) Delete |
8. In the Choose Reference Data dialog box, navigate to
the Atlanta personal geodatabase. Double-click the ﬂ ﬂ

personal geodatabase, click the altname table, then click

Add. — Matching Options
9 . . ‘I:’—-- Place Mame &lias Table... | <Manes
. In the Alternate Name table tab, click the Join ID
dropdown list, then click ALTNAME _ID. Speling sensifiviy:  [B) | —————————————
Minirmurn candidate score: IT .
Frimary table ~ Altemate Name table | Mirimum match score; Iﬁ —
Reference data:
C:Matantaatlanta. mdbhaltname ﬂ
The Alias Table dialog box appears.
e 11. Click the Browse button, then navigate to the Atlanta
Frefix Direction. |FRE_DIR =l geodatabase. Double-click the personal geodatabase,
P e [PRE_TvPE =l click the place_aliases table in the Atlanta geodatabase,
Altemate Stieet Name:  [57_namE =l then click Add.
Strest Type: |ST_TvPE =l 12. Click the Alias field dropdown arrow, then click NAME.
Suffix Direction: ISUF_DIH j
o 5 Alias Table EHE
Aliaz table:
Iplace_aliases ﬂ El
The ALTNAME ID column in the altname table and el —

the OBJECTID column in the streets feature class are
used to join the table and the feature class together.

Address Fields
Street or Intersection: ADDRESS j

10. On the right under Matching Options, click Place Name
Alias Table.

13. Click OK.
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14. Click OK in the New US Streets with AltName (GDB)

Geocoding Service dialog box. The new

yourLogin. Atlanta AltName geocoding service appears

in the Geocoding Services folder.

E1 Catalog

13 C:hatanta

% Databaze Connections

EI Geocoding Services

@ Create Mew Geocoding Service
: @, yourLogin Atlanta

: @ yourLogin Atlanta_altH ame
-- Internet Servers

-2\ Search Fesults

15. Click the File menu and click Exit to close ArcCatalog.

Now you can use this geocoding service to find out where

an address is located on a map.

Finding locations using alternate names and place
name aliases

1. Open a new map document in ArcMap. Don’t save the

map you created in the previous task.

2. Add the streets feature class from the Atlanta
geodatabase to your map.

Click the Find button on the Tools toolbar.
In the Find dialog box, click the Addresses tab.

v W

Navigate to the Geocoding Services folder, click the

yourLogin. Atlanta AltName geocoding service, and
click Add.
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8. Type

Click the Browse button to choose a geocoding service.

A street may have more than one name. For example,
“Atlanta Blvd™ is defined as an alternate name for “Old
10th St NE”. With the yourLogin.Atlanta AltName
geocoding service, “30 Old 10th St NE” and “30 Atlanta
Blvd” will both find the same location.

6. Type “30 Old 10th St NE” in the Street or Intersection
text box, then click Find.

 Find
Features I Route Locations  Addresses I
Chooge a geocoding service: Sian |
IyourLogin.Atlanta_AItName j

Mew Search |
Street or Intersection:lBD 0ld 10tk St NE] j EH Sears

Optiohs... I Show Standardization I ™ Show all candidates

Cancel

7. Right-click the candidate and click Add as Graphic(s) to
Map.

A graphic point representing the address’s location
appears on the map.

139

30 Atlanta Blvd™ in the Street or Intersection text
box, then click Find.

9. Right-click the candidate and click Flash Candidate

Location(s). You can see that both addresses are
matched to the same location on the map.

In addition to geocoding addresses, you can also
geocode place names that have been defined in the
place aliases table.




10. Type “Children’s Hospital” in the Street or Intersection
text box, then click Find.

11. Right-click the first candidate in the candidates list,

which has a score of 100, and click Add as Graphic(s)
to Map.

i Find 2] x|

Find |
Stam
aE| ——
Mew Search
Street or Intersection: IChiIdren's Hozpital j M

3

Cancel |

Featuresl Foute Locations  Addresses |

Chooge a geocoding service:
IyourLogin.Atlanta_AltName

Options... I Show Standardization | I Show all candidates

Right-click a row to shaw context menu.

Score | Side | LeftFrarm | LeftTa | RightFrom | RightTa | PreDir I PreType | Streeth.
100 R 18 50 19 51
7 R 2 7 1 73

AT T

Flazh Candidate Location(s]

Zoom to Candidate(z) and Flash
ul Add az Gra b

2 objects found.

Set Bookmark

The location of the hospital appears on the map as if
you had typed its complete address.

12. Click Cancel to close the Find dialog box.
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Creating geocoding services that use alternate names and
place name aliases is beneficial for people who know a
landmark’s name but not its address. It will also help in
situations where a street has more than one name.

GEOCODING TUTORIAL



Exercise 3: Creating a dynamic feature class

With ArcInfo™ and ArcEditor™ your geocoding results
can be dynamically linked to the original addresses if the
address table and the result feature class are stored in the
same geodatabase. With dynamic results, modifications to
the primary address table will cause the result feature class
to be updated automatically. ArcView® users will not be
able to complete this exercise.

1. Open a new map document in ArcMap.

2. Add the customers table in the Atlanta geodatabase to
your map.

W

Click the Tools menu, point to Geocoding, then click
Geocode Addresses. Or right-click the customers table
in the Source tab of the map’s table of contents and
click Geocode Addresses.

4. Click Add in the Choose a geocoding service to use
dialog box.

5. Inthe Add Geocoding Service dialog box, navigate to
the Geocoding Services folder, click the
yourLogin. Atlanta geocoding service, then click Add.

6. Click yourLogin.Atlanta in the Choose a geocoding
service to use dialog box, then click OK.
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Hame | Drescription | Add...

yourLagin.Atlanta Streets with Zone [Geodatabaze]

Canicel |

7. Inthe Geocode Addresses: yourLogin. Atlanta dialog

box, click the Browse button to define the Output
shapefile or feature class.

. In the Saving Data dialog box, navigate to the Atlanta

personal geodatabase, then double-click the personal
geodatabase. Click the Save as type dropdown arrow,
then click Personal Geodatabase feature classes. In the
Name text box, type “dynamic_results™. Click Save.

Saving Data
Lok in: IE Atlanta. mdb

1] atlanta_results

shieets
Mame: Idynamic_resu\ts|
Save s type: | Personal Geodatabase feature classes =l Cancel |
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9. Click Create dynamic feature class related to table.

Geocode Addresses: yourLogin_Atlanta EE3

Address table:

Icustnmers j ﬁl

—Addrezs Input Fields
Street or Interzection: IADDHESS j
ZokE: IZ”: j

— Output
' Create static snapshat of table inside new feature class
% Treate dynamic feature class related to table 9
Qutput shapefile or feature clazs:
C:\Atlantatatlanta mdbhdynamic_results = 0
[Eorfia heemmand; I j

Advanced Geomety Options. .. |

Geocoding Optioks. .. |

Help |

A new point feature class named dynamic_results will
be created in the Atlanta geodatabase. The point
features generated by the geocoding process will be
saved in that feature class. A relationship between the
table and feature class will be created.

10. Click OK to start geocoding.

o |

Cahicel |

When the geocoding process is finished, the Review/
Rematch Addresses dialog box appears.

11. Click Done.
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A Geocoding Result layer is added to the map. It shows
the points that were added to the dynamic_results
feature class.

12. Right-click the Geocoding Result layer in the map’s
table of contents and click Open Attribute Table.

Ef Attributes of Geocoding Result: dynamic_results

Shape* Statusz | Score | Side | ObjectiD*
¥ [Point 100|R
Paint 100(L
Paint 100|R
Paint 100|R

Street or Intersection
1171 PIEDMONT &VE NE
1670 PEACHTREE 5T ME
455 BEVERLY RD NE
241 16TH 5T Nw/

IIIZE
||| =

The first record in the table has the address

1171 PIEDMONT AVE NE in the Street or Intersection
column. The Status, Score, and Side columns contain the
values M, 100, and R, respectively. To see on the map
where this customer is located, select this record in the
table.

13. Minimize the Geocoding Result layer’s attribute table.

14. Right-click the customers table in the map’s table of
contents and click Open.

The address that appears for the first customer in the
table, Ace Market, i1s 1171 Piedmont Ave NE. That
customer has moved to a new address, 30 12th St. Its
ZIP Code remains the same. The customers table must
be updated with this information.

15. Click the Editor Toolbar button to show the Editor
toolbar.

+ | J:Iff@k?

Editor Toolbar
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16.

17.

18.
19.

Stop Editing

Saye Edits

On the Editor toolbar, click the Editor menu and click
Start Editing.

Type “30 12TH ST” in the Address column next to Ace
Market.

B3 Attributes of customers

OBJECTID® NAME ADDRESS

3012TH5T]

1E70'W PEACHTREE 5T ME
455 BEVERLY RD NE

241 1ETH ST Nw/

3

j—y

Ace Market

2| &ndrew's Gasoline
3|AP Supermarket
4| &tlanta Market

Click another record in the table.

Minimize the customers table and maximize the
Geocoding Result layer’s attribute table.

Ef Attributes of Geocoding Result: dynamic_results

Shape* Side | ObjectlD=
Faint
Faint
Faint
Faint

Street or Intersection
3012TH 5T
1670w PEACHTREE 5T NE
455 BEVERLY RD ME
241 16TH 5T Nw/

Score
g1
100
100
100

Status

I
m|m|r |
||| =

The new address was geocoded automatically, and the
corresponding values have been updated in the layer’s
attribute table. The Status, Score, and Side columns now
contain the values T, 81, and L, respectively. The value
“T” in the Status field stands for tied; two or more
candidates had the highest score. To see on the map
where Ace Market 1s now located, select this record in
the layer’s attribute table.
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20.

21.
22.

24,
25.
26.

27

28

29.

Now you need to add a new customer to the customers
table.

Minimize the Geocoding Result layer’s attribute table
and maximize the customers table.

Scroll down to the bottom of the customers table.

In the blank record after the last record in the table,
click in the NAME column. Type “Vine Cafe”.

48| Sidehattam |ne 1276% PEACHTREE ST Mw/

43|5J's Marker 400 POMCE DE LEON &VE NE
50| S outhemn Flavor E33JUMIFER 5T ME
13 Yine Cafd

Fecord: ﬂﬂl 51 _>|£| Show:W Selectedl Fecords [0 out of 50 Selected ]

A new blank record 1s added to the bottom of the table.

. In the same record, click in the ADDRESS column, then

type “379 VINE ST NW”.

Click in the ZIP column, then type “30314”.
Click in the TYPE column, then type “Cafe”.
Click in the SALES column, then type “10000”.

. Close the customers table. Maximize the Geocoding

Result layer’s attribute table, then scroll to the bottom.

A new feature was automatically added to the result
feature class representing the new address.

. On the Editor toolbar, click the Editor menu and click

Stop Editing. Click Yes to save your changes.

Click the File menu and click Exit. Click No to stop
ArcMap without saving this map.
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Geocoding addresses on an ArcSDE server

If ArcInfo or ArcEditor is installed on your computer, and if you
have access to an ArcSDE™ geodatabase, you can do server-
side geocoding. Instead of creating geocoding services on your
computer, you create and store them on the server. Server-side
geocoding services are easily shared by many users in an
organization. When you use them, the server will do the work of
matching addresses to geographic locations.

Once you have created a database connection that accesses the
appropriate ArcSDE server, you can copy the streets feature class
and the altname, customers, and place_aliases tables from the
Atlanta personal geodatabase to the ArcSDE geodatabase. This
tutorial could be completed by using data in the ArcSDE
geodatabase instead of the Atlanta personal geodatabase.

[ Catalog
EIEQ Databaze Connections
3| Add OLE DE Connection
3| Add Spatial Database Connection
Elg My ArcSDE connection, sde

El@. Geocoding Services

@ Create Mew Geocoding Service

-3, yourLogin.Atlanta

% wourLogindtlanta_AlM ame

If you choose to do so, create your geocoding services in the
Geocoding Services folder within the database connection and
use the data located in the same database. The result feature
classes created by the geocoding process can also be stored
within the ArcSDE geodatabase. Aside from these differences, the
geocoding process will be the same as what you experience when
you use client-side data and geocoding services to complete this
tutorial.

Copyright © 2001 ESRI. All rights reserved. ESRI and ArcView are trademarks of ESRI, registered in the United States and certain other countries;
registration is pending in the European Community. StreetMap, ArcGIS, ArcMap, ArcCatalog, ArcInfo, ArcEditor, and ArcSDE are trademarks of ESRI.

Other companies and products mentioned herein are trademarks or registered trademarks of their respective trademark owners.
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